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SRI INDU COLLEGE OF ENGINEERING&TECHNOLOGY
(An Autonomous Institution under UGC, New Delhi)
B. TECH COMPUTER SCIENCE AND ENGINEERING

INSTITUTION VISION

To be a premier Institution in Engineering & Technology and Management with competence,
values and socialconsciousness.

INSTITUTION MISSION

IM1: Provide high quality academic programs, training activities and research facilities.

IM2: Promote continuous industry-institute interaction for employability, entrepreneurship,
Leadership and researchaptitude among stakeholders.

IM3: Contribute to the economic and technological development of the region, state and nation.

DEPARTMENT VISION

To be a technologically adaptive center for computing by grooming the students as top notch
professionals.

DEPARTMENT MISSION

DM1: To offer quality education in computing.
DM2: To provide an environment that enables overall development of all the

stakeholders.DM3: To impart training on emerging technologies.
DM4: To encourage participation of stakeholders in research and development.



> Sri Indu College of Engineering & Technology
Sheriguda (V), R.R.Dist

Department Of Computer Science and Engineering

Program Educational Objectives (PEQ’s)

PEO-1 Higher Studies: Graduate with an ability to pursue higher studies and get employment in

Reputed institutions and organizations.
PEO-2 Domain Knowledge: Graduate with an ability to design and develop a product.
PEO-3 Professional Career: Graduate with excellence by multidisciplinary approach to achieve

successful Professional career.
PEO-4 Life Long Learning: Graduate with an ability to learn advanced skills to face professional

competence through lifelong learning.

PROGRAM OUTCOMES (POs) & PROGRAM SPECIFIC OUTCOMES (PSOs)

PROGRAM SPECIFIC OUTCOMES (PSOs)
PSO1 To Develop software projects using standard practices and suitable programming

environment.

PSO2 To identify, formulate and solve the real life problems faced in the society,
industry and otherareas by applying the skills of the programming
languages, networks and databases learned.
PSO3 To apply computer science knowledge in exploring and adopting latest technologies in

various inter- Disciplinary research activities.
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Sin
Suh:  SICET {Autonomous) - Academic & Fvaluation - Academic Calendar for
11 B.Tech - 1 & 1T Semester for the scademic year 2022-23 — Reg,
RE L]
The approved Academic Calendar for TT B Tech — I & T Semester [or the academic
Year 2022-23 is given helow:

ACADEMIC CALENDAR - 11 B.TECH -T & I SEMESTER
CIHL-(2021 -2022) o

ADMITTED BA'I( [ IR-20 Regulation.
~ ISEMESTER
Commencement of I Sem class work 26.09.2022
T Spell of Instructions (Including Dussehm Holidays). 26.09.2022 -36.11.2022 | 9 Weeks |
[ Dussehra Holidays. | 03102022 - 08.10.2022 | 1 Weck
I Mid Examinations for 11 B.Tech T Sem Students. 2R.11.2022-30.11.2022 | 3 Days

1 Spell of Tnsiructions.

01.12.2022 - 28.01.2023

B Weeks 3 Days |

Remedial Mid Test (RMT).

11'B.Tech I Semester End Examinations (Main) and
Supplementary Examirations,

13.02.2023 - 25.02.2023

Commencement of Class-Work for IT B.Tech - Il Semester 27.02.2023 (Monday).

Sunkranti Holidays, 12012023 - 16.01.2023 4 Days
I Mid Examinalions for Il B.'Tech T Sem Students. | 30.01.2023 - 01.02.2023 | 3 Days
b arali 3 , >, T « n 3 i i :
Preparation Holidays, Practical T.ab Examinations end 02.022023- 11022023 | 10 Days

2 Weeks

1l SEMESTER
Commencement of II Sem class work, 27.02.2023
|1 Spell of Instructions, 27022023 -22.04.2023 | 8 Weeks
1 Mid Examinations for 11 B.Tech. [l Sem. Stuents. 24042023 -26.04.2023 | 3 Days
11 Spell of Lastructions. ' 27.042023-05.07.2023 | 10 Weeks
Surmmer Vacation, 15052023 - 27052023 | 2 Wesks
1T Mid Examinations for [T B, Tech, I Sem. Students. 06.07.2023 - 08.07.2023 '3 Days
) P % PR T by Fesrminints
i e 1007.2023 - 1907.2023 | 10 Days
II B.Tech IT Sem'esler. I'nd Pxaminations (Main) and 20070023 - 02.08.2023 | 2 Weeks
_Supplementary Examinations. “
Commencement of Class-Work for 111 B.Tech - I Semester 07.08.2023 (Monday),
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Sri Indu College of Engineering & Technology
Sheriguda (V), R.R.Dist

PROGRAM OUTCOMES (POs)

PO

Description

PO1

Engineering Knowledge: To be able to apply knowledge of computing, mathematics,
Science and Engineering appropriate to the discipline

PO 2

Problem Analysis: To be able identify, formulate & analyze a problem, and ascertain
and define the computing requirements appropriate to its solution.

PO 3

Design & Development Solutions: To be able to design, implement, and evaluate a
computer-based system, process, component, or program to meet desired needs.

PO 4

Investigation of complex problems: To be able to identify and analyze user needs and
consider them in the selection, creation, evaluation and administration of
computer-based systems for providing valid solutions to complex problems.

PO 5

Modern Tool Usage: To posses skills for creating and in using contemporary
techniques, skills, and tools necessary for computing practice.

PO 6

Engineering & Society: To apply conceptual knowledge relevant to professiona
engineering practices in societal, health, safety, legal and cultural issues and their
consequences

PO 7

Environment & Sustainability: To be able to analyze the local and global impact of
computing on individuals, organizations, and society and work towards sustainable
development.

PO 8

Ethics: To understand contemporary professional, ethical, legal, security and social
issues and responsibilities.

PO 9

Individual & Team work: To Be able to function effectively as an individual and on
teams to accomplish a common goal.

PO 10

Communication: To communicate precisely and effectively both in oral and written
form with a range of audiences.

PO 11

Project management & finance: To apply engineering and management principles for|
managing and leading economically feasible projects in multi-disciplinary environments
with an effective project plan.

PO 12

Life Long Learning: To recognize the need for and an ability to engage in independent

& lifelong learning for continuing professional development.




SUB Name: IT WORKSHOP LAB

SUB CODE: R20CSE21L2
Course out comes (COs):

Department of Computer Science &Engineering
COs and POs & PSOs Mapping

Sri Indu College of Engineering & Technology
Sheriguda (V), R.R.Dist

C21L2.1 | Distinguish software’s and their installation.

C21L2.2 | Design word documents by learning word processing.

C21L2.3 | Create presentations by using different styles.

C21L2.4 | Introduce different way of hooking the PC on to the internet from home and
Workplace and effectively usage of the internet

would be covered

C21L2.5 | Define usage of web browsers, email, news groups and discussion forums

document.

C21L2.6 | List of tools & modules would enable the students in crafting professional word

Mapping of Course Outcomes(CO’s) with PO’s / PSO’s:

COURSE NAME: IT WORKSHOP LAB
Mapping of Course Outcomes(CQO’s) with PO’s:

Course PO | PO | PO | PO | PO
Outcomes | 1 2 3 4 |5
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(R20CSE21L2) IT Workshop Lab
Course Objectives:
The IT Workshop for engineers is a training lab course spread over 60 hours. The modules include
training on PC Hardware, Internet & World Wide Web and Productivity tools including Word, Excel,
Power Point and Publisher.

PC Hardware introduces the students to a personal computer and its basic peripherals, the process of
assembling a personal computer, installation of system software like MS Windows, Linux and the required
device drivers. In addition hardware and software level troubleshooting process, tips and tricks would be
covered. The students should work on working PC to disassemble and assemble to working condition and
install Windows and Linux on the same PC. Students are suggested to work similar tasks in the Laptop
scenario wherever possible. Internet & World Wide Web module introduces the different ways of hooking
the PC on to the internet from home and workplace and effectively usage of the internet. Usage of web
browsers, email, newsgroups and discussion forums would be covered. In addition, awareness of cyber
hygiene, i.e., protecting the personal computer from getting infected with the viruses, worms and other
cyber attacks would be introduced. Productivity tools module would enable the students in crafting
professional word documents, excel spread sheets, power point presentations and personal web sites using
the Microsoft suite of office tools and LaTeX.

PC Hardware
Task 1: Identify the peripherals of a computer, components in a CPU and its functions. Draw the block
diagram of the CPU along with the configuration of each peripheral and submit to your instructor.

Task 2: Every student should disassemble and assemble the PC back to working condition. Lab
instructors should verify the work and follow it up with a Viva. Also students need to go through the video
which shows the process of assembling a PC. A video would be given as part of the course content.

Task 3: Every student should individually install MS windows on the personal computer. Lab instructor
should verify the installation and follow it up with a Viva.

Task 4: Every student should install Linux on the computer. This computer should have windows
installed. The system should be configured as dual boot with both windows and Linux. Lab instructors
should verify the installation and follow it up with a Viva

Task S. Hardware Troubleshooting: Students have to be given a PC which does not boot due to improper
assembly or defective peripherals. They should identify the problem and fix it to get the computer back
to working condition. The work done should be verified by the instructor and followed up with a Viva.

Task 6: Software Troubleshooting. Students have to be given a malfunctioning CPU due to system
software problems. They should identify the problem and fix it to get the computer back to working
condition. The work done should be verified by the instructor and followed up with a Viva.

SRI INDU COLLEGE OF ENGINEERING & TECHNOLOGY (AUTONOMOUS)




COMPUTER SCIENCE & ENGINEERING

Internet & World Wide Web

Task 1: Orientation & Connectivity Boot Camp: Students should get connected to their Local Area Network
and access the Internet. In the process they configure the TCP/IP setting. Finally students should
demonstrate, to the instructor, how to access the websites and email. If there is no internet connectivity
preparations need to be made by the instructors to simulate the WWW on the LAN.

Task 2: Web Browsers, Surfing the Web: Students customize their web browsers with the LAN proxy
settings, bookmarks, search toolbars and pop up blockers. Also, plug-ins like Macromedia Flash and JRE
for applets should be configured.

Task 3: Search Engines & Netiquette: Students should know what search engines are and how to use the
search engines. A few topics would be given to the students for which they need to search on Google. This
should be demonstrated to the instructors by thestudent.

Task 4: Cyber Hygiene: Students would be exposed to the various threats on the internet and would be
asked to configure their computer to be safe on the internet. They need to first install antivirus software,
configure their personal firewall and windows update on their computer. Then they need to customize their
browsers to block pop ups, block active x downloads to avoid viruses and/or worms.

LaTeX and WORD

Task 1 — Word Orientation: The mentor needs to give an overview of LaTeX and Microsoft (MS)
office 2007/ equivalent (FOSS) tool word: Importance of LaTeX and MS office 2007/ equivalent
(FOSS) tool Word as word Processors, Details of the four tasks and features that would be covered in
each, Using LaTeX and word — Accessing, overview of toolbars, saving files, Using help and
resources, rulers, format painter in word.

Task 2. Using LaTeX and Word to create project certificate. Features to be covered: - Formatting Fonts in
word, Drop Cap in word, Applying Text effects, Using Character Spacing, Borders and Colors, Inserting
Header and Footer, Using Date and Time option in both LaTeX and Word.

Task 3: Creating project abstract Features to be covered:-Formatting Styles, Inserting table, Bullets and
Numbering, Changing Text Direction, Cell alignment, Footnote, Hyperlink, Symbols, Spell Check,
Track Changes.

Task 4 : Creating a Newsletter Features to be covered:- Table of Content, Newspaper columns,
Images from files and clipart, Drawing toolbar and Word Art, Formatting Images, Textboxes,
Paragraphs and Mail Merge in word.

Excel

Excel Orientation: The mentor needs to tell the importance of MS office 2007/ equivalent (FOSS) tool
Excel as a Spreadsheet tool, give the details of the four tasks and features that would be covered in
each. Using Excel Accessing, overview of toolbars, saving excels files, Using help and resources.

Task 1. Creating a Scheduler - Features to be covered. Gridlines, Format Cells, Summation, auto fill,
Formatting Text

Task 2 Calculating GPA - .Features to be covered: - Cell Referencing, Formulae in excel  average,
std.deviation, Charts, Renaming and Inserting worksheets, Hyper linking, Count function, Task 3:
Performance Analysis - Features to be covered:- Split cells, freeze panes, group and outline, Sorting,
Boolean and logical operators, Conditional formatting

SRI INDU COLLEGE OF ENGINEERING & TECHNOLOGY (AUTONOMOUS)




COMPUTER SCIENCE & ENGINEERING

LaTeX and MS/equivalent (FOSS) tool Power Point

Task 1: Students will be working on basic power point utilities and tools which help them create basic
power point presentation. Topic covered during this week includes: - PPT Orientation, Slide Layouts,
Inserting Text, Word Art, Formatting Text, Bullets and Numbering, Auto Shapes, Lines and Arrows in
both LaTeX and PowerPoint. Students will be given model power point presentation which needs to be
replicated (exactly how it’s asked).

Task 2: Second week helps students in making their presentations interactive. Topic covered during
this week includes: Hyperlinks, Inserting—Images, Clip Art, Audio, Video, Objects, Tables and Chans.

Task 3: Concentrating on the in and out of Microsoft power point and presentations in LaTeX. Helps
them learn best practices in designing and preparing power point presentation. Topic covered during

this week includes: - Master Layouts (slide, template, and notes), Types of views (basic, presentation,
slide slotter, notes etc), and Inserting — Background, textures, Design Templates, Hidden slides.

REFERENCE BOOKS:
1. Comdex Information Technology course tool kit Vikas Gupta, WI LEY Dreamtech
2. The Complete Computer upgrade and repair book, 3rd edition Cheryl A Schmidt, WILEY
Dreamtech
Introduction to Information Technology, ITL Education Solutions limited, Pearson Education.
PC Hardware - A Handbook Kate J. Chase PHI (Microsoft)
LaTeX Companion— Leslie Lamport, PHI/Pearson.
IT Essentials PC Hardware and Software Companion Guide Third Edition by David Anfinson
and Ken Quamme. — CISCO Press, Pearson Education.
7. IT Essentials PC Hardware and Software Labs and Study Guide Third Edition by Patrick
Regan — CISCO Press, Pearson Education.

o g~ w
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Sri Indu College of Engineering & Technology
Sheriguda (V), R.R.Dist

Department of Computer Science & Engineering
LIST OF EXPERIMENTS

(R20CSE21L2) IT Workshop Lab
2022-2023 11 Year —I Semester CSE

S.No Experiment Name Number of

Weeks Page No.

PC Hardware:

Week 1 — Task 1: Every student should identify the peripherals of a
1 computer, Components in a CPU and its functions. Draw the block 1-3
diagram of the CPU along With the configuration of each peripheral
and submit to your instructor. Every student should

Disassemble and assemble the PC back to working condition.

4-16

Week 2 -Task 2: Every student should individually install operating
2 system like Linux or MS windows on the personal computer. The 4-5
system should be configured as dual boot with both windows and
Linux.

17-33

Week 3 - Task 3: Hardware Troubleshooting: Students have to be given
3 a PC which does 6-8
not boot due to improper assembly or defective peripherals. They should 34-35
identify the problem and fix it to get the computer back to working
condition.

Week 4 - Task 4: Software Troubleshooting: Students have to be given
4 a malfunctioning CPU due to system software problems. They should 9-10
identify the problem and fix it to get the computer back to working
condition.

36-37

Internet & World Wide Web
Week 5 - Task 1: Orientation & Connectivity Boot Camp: Students 11-13
should get connected to their Local Area Network and access the 38-40
Internet. In the process they configure the TCP/IP setting. Finally
students should demonstrate how to access the websites and email.

Week 6 - Task 2: Web Browsers, Surfing the Web: Students customize
6 their web browsers with the LAN proxy settings, bookmarks, search 14-16
toolbars and pop up blockers. Also, plug-ins like Macromedia Flash
and JRE for applets should be configured

41-43

Week 7 - Task 3: Search Engines & Netiquette: Students should know
7 what search engines are and how to use the search engines. Usage of 17-18
search engines like Google, Yahoo, ask.com and others should be
demonstrated by student.

44-46

Week 8 - Task 4: Cyber Hygiene: Students should learn about viruses
8 on the internet and install antivirus software. Student should learn to 19-20

customize the browsers to block pop
ups, block active x downloads to avoid viruses and/or worms.

47-48

Week 9 Task 5: Develop home page: Student should learn to develop
9 his/her home page using HTML consisting of his/her photo, name, 21-22 49-51
address and education details as a table and his/her skill set as a list.




10

Productivity tools: LaTeX and Word

Week 10 - Task 1: Using LaTeX and Word to create project
certificate. Features to be covered:-Formatting Fonts in word, Drop
Cap in word, Applying Text effects, Using Character Spacing, Borders
and Colors, Inserting Header and Footer, Using Date

23-25

52-53

11

Week 11 - Task 2: Creating project abstract Features to be covered:-
Formatting Styles, Inserting table, Bullets and Numbering, Changing
Text Direction, Cell alignment, Footnote, Hyperlink, Symbols, Spell
Check, Track Changes.

26-27

54-58

12

Week 12 - Task 3: Creating a Newsletter: Features to be covered:-
Table of Content, Newspaper columns, Images from files and clipart,

Drawing toolbar and Word Art,
Formatting Images, Textboxes, Paragraphs in word.

28-29

59-67

13

Week 13 - Task 4: Spreadsheet Orientation: Accessing, overview of
toolbars, saving spreadsheet files, Using help and resources. Creating a

Scheduler:- Gridlines, Format
Cells, Summation, auto fill, Formatting Text

30-31

68-69

14

Week 14 - Task 5: Calculating GPA - .Features to be covered:- Cell
Referencing, Formulae in spreadsheet — average, std. deviation, Charts,
Renaming and Inserting

worksheets, Hyper linking, Count function, Sorting, Conditional
formatting.

32-34

70-75

15

Week 15 - Task 6: Creating Power Point: Student should work on
basic power point utilities and tools in Latex and Ms Office/equivalent
(FOSS) which help them Create basic power point presentation. PPT
Orientation, Slide Layouts, Inserting Text, Formatting Text, Bullets
and Numbering, Auto Shapes, Lines and Arrows, Hyperlinks,

Inserting Images, Tables and Charts

35-37

76-80

Text Books (to be acquired by the Students)

Book 1

WILEY Dreamtech

Comdex Information Technology Course tool kit _Vikas Gupta

Reference Books

Book 2

Introduction to Information Technology, ITL Education Solutions
limited, Pearson Education.

Book 3

LaTeX Companion — Leslie Lamport, PHI/Pearson

Book 4

Comdex Information Technology course tool kit Vikas Gupta, WILEY Dreamtech

Book 5

IT Essentials PC Hardware and Software Companion Guide Third Edition by David
Anfinson and Ken Quamme. — CISCO Press, Pearson Education.

Book 6

PC Hardware and A+ Handbook — Kate J. Chase PHI (Microsoft)
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TASK 1:

Every student should identify the peripherals of a computer, components in a CPU and
its functions. Draw the block diagram of the CPU along with the configuration of each
peripheral and submit to your instructor. Every student should disassemble and
assemble the PC back to working condition.

AIM: To identify the peripherals of a computer, assemble and disassemble the system.

Software Requirement: No Software Required.

Hardware Requirement: Desired Configuration for the above task is

Safety Precautions:

a > w0 e

System unit

CPU

Mother Board

FDD

CD ROM Drive

HDD

Ethernet Card

Monitor, Keyboard, Mouse & Speakers

Beware of electrostatic discharge (ESO)

Build computer on a hard surface, away from concepts.
Wear shoes and the short sleeved cotton wear.

Use Phillips, head screw driver.

Keep the components away from moisture.

6. Awvoid using pressure while installing.
BLOCK DIAGRAM OF COMPUTER

BLOCK DIAGRAM OF

WOO=-<00 ~CTVI-—

o

u

Central Processing Unit t

cPU —_— E

I Control Unit I t
I Arithmetic/Logical Unit |

4 \ 4 s

. t

Memory Unit ?

a

< g

e

IT Workshop Lab Manual
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Peripherals of a computer: r—

1. Cabinet:
e ltisused to install all hardware devices like(mother board, SMPS,HDD, CD Rom, FDD)
e It has Start, Restart Button, Led’s, Audio and USB Connecters are available at front side.\\

2. Monitor: :

e Monitor of a computer is like a television screen.

e It displays text characters and graphics in colors or in shades of grey.

e The monitor is also called as screen or display or CRT (cathode ray tube). In the moni
will be displayed in pixels format.

i. 800 by 600 pixels
ii. 1024 by 768 pixels

w

Key Board: / ‘

Key board is like a type writer, which contains keys to feed the data or information into the computer
Keyboards are available in two modules. These are

% standard key board with 83-88 keys
+«+ enhanced key board with 104 keys or above

4. Mouse:

e Every mouse has one primary button (left button) and one secondary button (right button).
e The primary button is used to carry out most tasks, where as secondary button is used in special cases
you can select commands and options

5. Printer:

e A device that prints images (numbers, alphabets, graphs, etc...) on paper is known as Printer.
e We have different types of printers to take printouts. These are as follows:

i. Dot matrix printer ii. Inkjet printer

IT Workshop Lab Manual Page 15



6. Speakers:

. Speakers make your system much more delightful to use entertain you while you are working on
computer

7. Scanner: Scanner used to scan images and text.

8. System board/Motherboard

This is the major part of the PC hardware

It manages all transactions of data between CPU peripherals.

which holds the Processor, Random Access Memory and other parts, & has slots for expansion cards
It is rectangle shape

IT Workshop Lab Manual Page 16



Socket 478
@

9. Socket 478:

It use 478 — PIN MICROPGA package it is used installing CPU Fan

. . Retent'on ‘
Itis square type deS|gn. Moqulle

10. CPU

The central processing unit contains the heart of any computer, the processor. The processor is fitted

on to a Mother Board. The Mother Board contains various components, which support the functioning
of aPC.

e Itis brain of the computer
e It is square shape

INTEL&®'81
PENTILM®Y
1.66HZ/ 25674002 1.75¢
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11. Ram Slots:

e Ram slots are used to install the rams

e Itis large rectangle shape and each ending has small clips.

e There two type ram slots

e SD Ram ---------- Two Gaps (synchronous DRAM) is a generic name for various kinds of dynamic
random access memory (DRAM) that are synchronized with the clock speed that the microprocessor is
optimized for. This tends to increase the number of instructions that the processor can perform in a

given time.

e DDR Ram ------- One Gap (Double Data Rate Synchronous DRAM: A clock is used to read data from
a DRAM. DDR memory reads data on both the rising and falling edge of the clock, achieving a faster
data rate.)

DDR RAM & SD RAM Slots

S

Random Access Memory
SD (Synchronous Dynamic) RAM

12. North Bridge:

-
e ltisalso called as controller :

e Itis nearby socket 478
e |t placed middle of the mother board
e |t converts electronic signals to binary values and binary values to electronic signals

KOB P4M25§ NDFSMx

13. South Bridge:

e It is controls major components mother board and it back bone of the input out devices
e Itis communicates PCl slots, IDE-1, IDE-2, floppy connecter, BIOS chip.
e It nearby CMOS battery

IT Workshop Lab Manual Page 18



14. CMOS Battery:

e Computer is using a coin shape battery
e It generates the clock signal and it manage system continues time.

15. Primary & Secondary (IDE-1 & IDE-2):

e Itisalso called as IDE-1, IDE-2.
e It used to connecting Hard Disk Drive, CD ROM, DVD ROM.

16. Input & Output ports:

e 10 ports are used to connecting 10 device such as key boards, mouse, monitor, printer, scanner,
speakers etc...

Ports (Front View)
= | Cc

:t - Ethernet Port
p -

: B_~=ratel Port | Game Fort |
Mouse Port e Game Port
\.' e ] e 5 y
!

L

e —— = S=p—

Keyboard Port § _ : Serial Port VGA Port Sound Ports

17. AGP Slot & AGP Card:

e AGP Slot is used install the AGP card.
e AGP back view same as VGA port (15-female pins) and used to connecting the monitor’s c. This slot
is above PCI slots and its color is Black or Brown

IT Workshop Lab Manual Page 19



CNR, PCI, AGP Slots

18. CI Slots &PCI (Expansion) Cards:

e PCl slots are used to install the PCI cards such as

i. LAN (Ethernet) Card---Back view Ethernet port

iii. TV Tuner (Internal) Card - Dish Pin connecter
iv. PCI Slots are white or yellow color
v. PCI Card has Single gap only

IT Workshop Lab Manual Page 20



19. BIOS Chip:
e BIOS controls how the operating system and hardware wok together

e BIOS identification is BIOS name is available on chip or mother board
BIOS

20. AT X Power connecter:

e ATX power connecter is used to connect ATX power plug (This is from SMPS)
e Itis white color and it has ATX Name is available on Mother Board
e ATX Power connecter has 20/24 pins available.

e Typical ATX 1.3 power supply. From left to right, the connectors are 20-pin motherboard, 4-pin
"P4connector”, fan RPM monitor (note the lack of a power wire), SATA power connector (black),
"Molex connector™ and floppy connector.

21. Floppy connecter:

e Floppy connecter is used to connect Floppy Disk Drive.
e This is beside of ATX power connecter and Name FDD is available on the mother board.

< (i
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22. Bus Cables or Data cables:

e A Bus is a collection of wiresthrough which data is transmitted from one device to another
device cables are two types

e IDE cable: it used to connect HDD, CD ROM, DVD ROM
e FDD cable: it used to connect FDD (braking or manufacture defecting)

Cables

Floppy Drive Cable IDE Cabies

23. Hard Disk Drive:

e The hard disk drive is the main, and usually largest, data storage device in a computer
e The operating system, software titles and most other files are stored in the hard disk drive
e Identifications is the panel name is Hard Disk dive

IDE — Integrated Drive Electronics

Connecto

Hard Disk Drive (HDD)
24. CD ROM Drive & CD-Writer:

e CD-Rom (Compact Disk Read only Memory) Drive is a device that reads the information from
Compact Disks (CD).

e CD-Writer is used to write the data into Compact Disks.
e Identification is the panel name is CD Writer
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25. Floppy Disk Drive:

e The floppy disk drive is used to read the information stored in floppy disks.
e Floppy disks also called as a diskette.
e Identification is smaller than CD Writer.

26. SMPS:

e SMPS is used to supply the power to Mother Board HDD,CD ROM, FDD
e In SMPS holds a transformer, voltage control and fan
e ldentification is the rectangular box shape and panel name is switching mode power supply.
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Assembling & Disassembling the System Hardware Components of the

Personal Computer

1. Setting the Cabinet ready:-
e Check how to open the cabinet and determine where to fix the components.
e Determine if the case has the appropriate risers installed.
2. Fitting the Mother board.
e Line up the patch on the motherboard (ps/l, USB, etc) with the appropriate
holes in the block panel 1/O shield of the case.

e Check the points where you and to install

e Install them and make the mother board sit on them and fix screws if required.

3. Installing the CPU

o Raise the small lever at the side of the socket.

¢ Notice that there is a pin missing at one corner, determine the direction to fit
in the processor.

e You should not force the CPU. When inserting it. All pins should slide
smoothly into the socket.

e Lock the lever back down.

4. Installing CPU fan

e Install the heat sink over it (Different type for each processor). Heat sink
/CPU fan.

5. Fitting the RAM:

e The RAM must be suitable for motherboard.
e There are currently 3 types of RAM available.
a) SD RAM.
b) DDR SD RAM.
c) RDRAM.
e The mother board‘s chipset determines which type of RAM may be used.

6. Installing SMPS
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7. Installing the ATX Power Connector

ATX Connectors:
e PS, Mouse.
e Key board.
e USB.

e Parallel (Prints)
e Serial COML1.

e Serial COM 2.

e Joystick.

e Sound.
8. Installing the HDD and Floppy disk:

Place the floppy and hard disks in their slots.
Leave some space above HDD to prevent heat building.

Check the jumper configuration.

A wnp e

Fix the screws.

9. CD ROM Drive :
e CD-ROM drive is similar to installing a hard disk.
e 1%t check that the jumper configuration is correct.

e Fix the screw.
10. LAN Card

11. Connecting the ribbon Cables and Front panel connections
e Attach the long end of the cable to the IDEU connector on the motherboard
first. The red stripe on the IDE cable should be facing the CD Power.

12. Final Check:
e Mother board jumper configurations are the settings for the processor operator.
e Drive jumper settings, master/ slave correct?
e Is the processor, RAM modules and plug in cards finally seated in their sockets?
e Did you plug all the cables in? Do they all fit really?

e Have you frightened all the screws in plug- in cards or fitted the clips?
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Are the drive secure?

Have u connected the power cables to all driver?

Powering up for the first time:

1.

2
3.
4. If everything is connected as it should be

Ensure that no wires are touching the CPU heat sink fan.

. Plug your monitor, mouse and keyboard.

Plug in power card and switch the power supply.

All systems, fans should start spinning

U should hear a single beep and after about 5-10 sec

Amber light on monitor should go green

You will see computer start to boot with a memory check
Now check front LED‘S to see if u plugged them in correctly
Check all other buttons

Power afford change any wrong settings

Why should one learn about hardware?
Troubleshoot you and save time.

1.
2
3.
4

. Install extra memory.

5.

. Knowing about system internals and components.

Very easy installation for modern hardware.

Removing components.

TEST DATA: No Test Data for This Experiment
ERROR: No Errors for this Experiment
RESULT: Assembling and disassembling the system is completed

Viva QO & A:

1) Define hardware?

2) Define software?

3) What are the functional units of a computer?
4) |DE Stands for

5) What are the other names for LAN card

6) What is the use of LAN card?

7) What are the input and output devices?

8) No display. What is the problem?

9) Differentiate SRAM and DRAM.

10) SLMM full name.

11) What is CMOS and CMOS battery?

12) What are the full names of ATA, SATA, PATA and ATX?
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TASK 2:

Every student should individually install operating system like Linux or MS
windows on the personal computer. The system should be configured as dual
boot with both windows and Linux.

AlIM: To install Windows XP

Software Requirement: Windows XP Compact Disc Hardware Requirement:
Personal computer

PROCEDURE:

1. Keep on press the delete button and go to advanced BIOS

feature [ BIOS- Basic Input Output System ]

2. And go to boot sequence. Select first boot drivers. CD ROM
and press F10 to save the bios feature. Yes and then enter.
Press any key to boot from CD. Press enter to setup windows
XP.

F8 = To agree the license.
Press ESC to don‘t repair the windows XP setup.
Press _p‘to delete the previous partitions. Then press enter.
Press _L‘to delete the partition.

Press _C‘to create the partition in the UN partition space.

N o o &~ w

Press enter to setup windows XP on the selected items.
BASIC FILE SYSTEMS:

FAT: File Allocation Table.

NTFS: New Technology File System.

Format the create using NTFS partition.
BASIC STEPS IN INSTALLATION:-

Collecting information.
Dynamic update
Preparing installation

Installing windows.

o &~ w0 N e

Tracking installation

Screen shots of windows XP Installation
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1. Insert the Windows XP CD into your computer and restart your computer. If
prompted to start from the CD, press SPACEBAR. If you miss the prompt (it only

appears for a few seconds), restart your computer to try again.

Press any key to boot from CD or DUD._

2. Windows XP Setup begins. During this portion of setup, your mouse will not
work, so you must use the keyboard. On the Welcome to Setup page, press
ENTER.

Hindouws XP Professional Setup

Welcome to Setup.
This portion of the Setup program prepares Microsoftd(R>
Windows<R> XP to run on vour conmputer.

 To set up Windows XP now. press ENTER.

« To vepair a Windowus installation using
Recovery Conzole, prezs R,

= To guit Setup without installing Windows ¥P, press F

3. On the Windows XP Licensing Agreement page, read the licensing
agreement. Press the PAGEDOWN key to scroll to the bottom of the agreement.
Then press F8.
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WVindows XP Licensing Agreement

END-USER LIC S AGREEMENT FOR MICROSOFT SOFTWARE
WINDOW “P PRC EDITION SERVICE PACK 2

31¥ INSTALLI
; THE SOFTWA

IN
FOR A FULL REFUND.

GRANT OF LICENSE.
0 grants wou w Fo owing right:
yly with a CE NS and conditions of

allation anc
Ay and »
Iter. suc \
< Workst

4. This page enables you to select the hard disk drive on which Windows XP will be
installed. Once you complete this step, all data on your hard disk drive will be
removed and cannot be recovered. It is extremely important that you have a recent
backup copy of your files before continuing. When you have a backup copy, press D,
and then press L when prompted. This deletes your existing data. Press ENTER to

select Un partitioned space, which appears by default.

Hindows XP Professional Setup
The following list shous the ing partitions and
unpartitioned space on this c© exr.
Uze the UP and DOWN ARROW kevs to select an item in the list.
 To set up Windows XP on the selected item, press ENTER.
= To create a partition in the unpartitioned space. press C.

« To delete the selected partition, press D,

16377 NB Disk @ at Id ® on bus ® en atapi [MBRI]

5. Press ENTER again to select Format the partition using the NTFS file system,
which appears by default.
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Hindouws XP Professional Setup

A new partition for Windows XP has been created on

16379 MB Dick 8 at Id 8 on bus 8 on atapi [MBRI.

This partition must now be Formatted.

From the list beloy select a Fi tem For the ne rtition.

Use the UP a RROW keys te the file you want,

RP,

6. Windows XP erases your hard disk drive using a process called formatting and
then copies the setup files. You can leave your computer and return in 20 to 30
minutes.

Please wait while Setup formats the partition
C: Partitionl [New (Raw>] 16370 HB < 16378 MB free)

on 16379 MB Disk @ at Id @ on bus @ on atapi [(MBR].

Setup is formatting...

7. Windows XP restarts and then continues with the installation process. From this
point forward, you can use your mouse. Eventually, the Regional and Language
Options page appears. Click next to accept the default settings. If you are
multilingual or prefer a language other than English, you can change language

settings after setup is complete

IT Workshop Lab Manual Page 30



=
Regional and Language Options o
You can customize Windows XP for different regions and languages. l@

)

Regional and Languages Options allow pou to change the way numbers. dates,
currencies and the ime are displayed. You can also add support for additional

‘languages. and change your location setting.

The Standards and formats setting is set to English [United States), and the
location is set to United States.

To change these sellings, click Customize. Customize...

Text Input Languages allow you to enter text in many different languages. using
a variety of input methods and devices.
Your default text input language and method is: US kevboard layout

To view or change your current configuration . click Details, Detais... I

< Back MNext >

8. On the Personalize Your Software page, type your name and your organization
name. Some programs use this information to automatically fill in your name when
required. Then, click Next.

Windows XP Professional Setup

Personalize Your Software

Setup uses the information you provide about yourself to personalize your Windows
XP software,

ﬁ Tyvpe your full name and the name of yowr company or organization.
s

MName: lLa Feria High School

Drganization: [Lz Feria ISD

9. On the Your Product Key page, type your product key as it appears on your
Windows XP CD case. The product key is unique for every Windows XP installation.
Then, click Next.
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3 4
Your Product Key \‘;"‘7
Your Praduct Key uniquely identifies your copy of Windows XP, ‘@

"0 PRODICT KEY; " The 25-character Product Key appears on the yellow stickes
| I on the back of your Windows CD folder.

Type the Product Key below:

Product Key:
I.AAAAA - |12345 - |asass 2 [12345 B Yy

10. On the Computer Name and Administrator Password page, in the Computer
name box, type a name that uniquely identifies your computer in your house, such as
FAMILYROOM or TOMS. You cannot use spaces or punctuation. If you connect
your computer to a network, you will use this computer name to find shared files and
printers. Type a strong password that you can remember in the Administrator
password box, and then retype it in the Confirm password box. Write the password

down and store it in a secure place. Click Next.

Windows XP Professional Setup L i]
Computer Name and Administrator Password Tt
You must provide a name and an Administrator password for your computer, [@

=1 Setup has suggested a name for your computer. If your computer is on a
:ﬁ! network, yowr netssork administrator can tell you what name to use.

Computer name: I KITCHEN

Setup creates a user account called Administrator. You use this account when
you need full access to your computer.

Type an Administrator password.

Sdministrator password: I' sssese

Confirm password: loo.oooo

11. On the Date and Time Settings page, set your computer‘s clock. Then, click the
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Time Zone down arrow, and select your time zone. Click Next.

Windows XP Professional Setup T Lj

Date and Time Settings pr—ry
Set the correct date and time for your Windows computer. |

~ Date & Time
| Thursday . Febmaw 16,2006 ~| | sataaPM =
[~ Time Zone
g [(GMT-05:00) Eastem Time (US & Canada) |
[V Automatically adiust clock for daylight saving changes

12. Windows XP will spend about a minute configuring your computer. On the
Networking Settings page, click Next.

Windows XP Professional Setup

Networking Settings
Instaling network software allows you to connect to other computers, networks,
and the Internet.

%ﬂ‘ Choose whether to use typical or custom settings:
=%

(+ Typical settings
Creates network connections using the Chent for Microsoft Networks, File
%Pm Shating for Maero:ThNetwofks QoS Packet Scheduler, and the

(" Custom settings
Allows you to slly fig king components.

< Back Next >

13. On the Workgroup or Computer Domain page, click Next.

Windows XP Professional Setup [ .

‘Workgroup or Computer Domain
A workgroup is a collection of computers that have the same workgroup name. &
domain is a collection of computers defined by a network administrator.

Do you want this computer to be a member of 3 domain?
{Y'ou may need to obtain this nf tion from your ik adenini or.)

No, this computer is not on a network, or is on a network without a domain.
Make this computer a member of the following workaroup:

[WORKGROUP

€ Yes, make this ¢ & meimber of this Tokws domar

< Back Next >
S

14. Windows XP will spend 20 or 30 minutes configuring your computer and will
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Automatically restart when finished. When the Display Settings dialog appears, click
OK

Display Settings TR x|
To improve the appearance of visual elements, Windows will automatically
adjust your screen resolution,

15. When the Monitor Settings dialog box appears, click OK.

Monitor Settings _>_(_|

Windows adjusted your screen resolution, If you can read
- this text, click OK to continue.

Reverting in 25 seconds Ok [kJ | e I

16. The final stage of setup begins. On the Welcome to Microsoft Windows page,
click next.

Py y—
*% Windows

Welcome to Microsoft Windows

Thank you for pureh

Lar% aporid o few e

17. On the Help protect your PC page, click Help protect my PC by turning on
Automatic Updates now. Then, click
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%3 Windows
Help protect your PC

W Aot U
Susomaticutly

/'@ Help protect my PC by turning on Automatic Updates now
ded)

No informantion ts collected that cin be used (o identity you or contact you.
Pless ROteasy 44 erd

18. Windows XP will then check if you are connected to the Internet: If you are
connected to the Internet, select the choice that describes your network connection on
the Will this computer connect to the Internet directly, or through a network?

Page. If you‘re not sure, accept the default selection, and click Next

3 Windows

Will this computer connect to the Internet
directly, or through a network?

L3

19. If you use dial-up Internet access, or if Windows XP cannot connect to the
Internet, you can connect to the Internet after setup is complete. On the How will
this computer connect to the Internet? Page, click Skip.

2 Windows

How will this computer connect to the Internet?
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20. Windows XP Setup displays the Ready to activate Windows? Page. If you are
connected to the Internet, click Yes, and then click Next. If you are not yet connected
to the Internet, click No, click Next, and then skip to step 24. After setup is complete,
Windows XP will automatically remind you to activate and register your copy of

Windows XP

‘2 Windows

Ready to activate Windows?

SORWSID PIracy, DIeAse Acivate YOUS cOPY Of WINGOWS now

You dont need o give your mame o other personal information when you activete Windows.

21. On the Ready to register with Microsoft? Page, click Yes, and then click Next.

3 Windows

Ready to register with Microsoft?

Regiater ontne BETOGOR, Snd well oMy YOU of new products, product updates, events, pramolions, and special offers hat
YOu mury be interested in

22. On the collecting registration information page, complete the form. Then,
click Next.
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*» Windows

Collecting Registration Information

TO v 10 he ned box, prosn TAB on your koytoant

Eirgtname

LAELname

Urtad Ststes

oy allen@corozo cor

®

£o0 hblo,
click vare Or pives Y

wo [Bb|

23. On the Who will use this computer? page, type the name of each person who
will use the computer. You can use first names only, nicknames, or full names. Then
click Next. To add users after setup is complete or to specify a password to keep your

account private, read Create and customize user accounts.

¢4 Windows

Who will use this computer?

Type e nams oledch person y
Chn oS onAg he Wiy YOu Wi
CUshikze o seskiop,

Xow name.

24. On the Thank you! Page, click Finish.
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2 Windows

JThank you!

Cangralilations, youre reaoy |

Foe hedp,
cliek vere of presR F1

Congratulations! Windows XP setup is complete.

TEST DATA: No Test data for this Experiment

ERROR: No Errors for this Experiment

RESULT: Installation of Windows XP is completed.

VivaQ & A:

Give the advantages of Windows XP?
Who wrote Windows XP?

How to Boot from CD in Windows XP?

How to Install Windows XP?

How to Check IP address in Windows XP?

How to Create User Account in Windows XP?

How to Disable/Enable automatic updates in Windows...

How to find MAC address in Windows XP?

How to Disable and Enable automatic updates in Windows XP?

10 In Windows NT, NT stands for

11.MS DOS uses

12. The first version which become reasonably popular was
13. The desktop has several

©9°.\'.°’.U":'>9°!\’!—‘
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(B) AIM: To install Linux in system

Software Requirement: Linux Compact Discs

Hardware Requirement: Personal computer

PROCEDURE:

1. Language Selection

] Using your mouse select the language you would prefer to use for the
installation
| Click next to continue.

2. Key Board Configuration:

] Using your mouse select the correct layout type for the keyboard you
would prefer to use for the installation and as the system default.

| Once you have made the selection click next to continue.
3. Mouse Configuration:

1 1f you have a PS/2, USB or Bus mouse you do not need to pick a port and
device. If you have a serial mouse, you should choose the correct port and
device that your serial mouse is on.

o The Emulate 3 buttons checkbox allows you to use a two-button mouse as
if it had three buttons. If you select this check box you can emulate a

third —middlel button by pressing both mouse buttons simultaneously.
4. Installation Type:

| Choose the type of installation you would like to perform.
1 Your options are Personal desktop, Workstation, Server, Custom and

upgrade

5. Disk partition Setup:

] You can chose automatic partitioning or manual partitioning using Disk
Druid of fdisk.
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| Automatic partitioning allows you to perform an installation without having
to partition your drives yourself.

| Automatic partitioning allows you to have some control concerning what

data is removed from your system.

1 Your options are:
Remove all Linuxpartitionsonthissystem.

Removeallpartitionsonthissystem
=Y
Keep all partitions and use existing free space.

| To partition manually choose either Disk druid or fdisk partitioning tool.

J Lick next once you have made your selections.

6. Partitioning your system:

1 1f you chose automatic partitioning and did not select Review
skip ahead

1 If you choose automatic partitioning and selected review you can

either accept the current partition settings (click next) or modify
the setup using Disk Druid, the manual partition tool.

| 1f you choose manual partition with disk skip ahead.
- At this point you must tell the installation program where to
install Linux. This is done by defining mount points for one or

more disk partitions in which Linux will be installed.

7. Adding Partitions:

To add a new partition select new button, a dialogue box appears.
Select the options and click ok
8. Boot Loader Configuration:

Boot loader is the first software program that runs when a computer starts.
The installation program provides two boot loaders GRUB ( GR and

Unified Boot Loader) which is the default and LILO
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If you do not want GRUB as your boot loader click Change Boot Loader.
O

You can then choose to install LILO or choose not to install boot loader at

all by clicking Do not install boot loader on the change boot loader
button.

Network devices are automatically detected and displayed in Network
Devices list,
Select a network device and click Edit

Here you can configure IP address and net mask of the device.
9. Firewall configuration:

| Offers firewall protection for enhanced protection.
1 A properly configured firewall can greatly increase the security of the

system.
10. Time zone configuration:
You can set your time zone by selecting your computers physical location or
by specifying your time zones offset from Universal Time.

11. Account Configuration:

o Allows to set Root password or user accounts

| Root count is similar to the administrator password that you set up in Win
NT.

o Click add button to add a new non-rot user.
Enter the details and click OK.

12. Packing group selection:
You can select package groups which groups components together or
individual packages or a combination of the two.

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment
RESULT: Installing the OS of Linux is completed
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Viva QO & A:

Give the advantages of Linux over other OS?
Who wrote Linux?
What are the Flavors of Linux?

What is Linux?

What is the difference between UNIX and Linux?
What is the advantage of Linux?

What is the GUI?

What is SMTP?

What is Linux Kernel?

10.What are the basic components of Linux?

© 00N kA e
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TASK 3:

Hardware Troubleshooting: Students have to be given a PC which does not
boot due to improper assembly or defective peripherals. They should
identify the problem and fix it to get the computer back to working

condition.

AIM: Hardware troubleshooting
Software Requirement: No software required
Hardware Requirement: Personal computer
Troubleshoot:-
1. If you hit the power button & nothing happened.
| Check all power connections.
| Check for power on mother board.
2. If the system turns on but does not beep or begin to boot up.
| Remove all components except motherboard/ cpu / moniter

check by giving power to them

Computer error beeps codes:

No beep: short, no power, bad CPU/ MD, loose peripherals.
One beep: everything is normal & computer posted tax.
Two beeps: post / CMOS error.

One long beep One short beep: Motherboard problem.
One long beep two short beep: video problem.

One long beep 3 short beeps: video problem.

3 long beeps: keyboard error.

Repeated long beep: memory error.

Continuous high- low beeps: CPU overheating
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TEST DATA: No Test data for this Experiment

ERROR: No Errors for this Experiment
RESULT: Doing the Hardware troubleshooting is completed

Viva Questions and Answers:

1. What is the hardware trouble shooting?
2. What is the device manager?
3. What are the troubles related to the monitors?
4. What is ASCII?
5. What is an IP address?
6. What is bandwidth?
7. What does HTTP mean?
8. How do you secure a computer network?
. What does network mean?
10. How would you recover lost files from a system infected by a virus?
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TASK4:

Software Troubleshooting: Students have to be given a malfunctioning CPU
due to system software problems. They should identify the problem and fix it
to get the computer back to working condition.

AlIM: Software troubleshooting

Software Requirement: Malfunctioning CPU due to system software

Hardware Requirement: Personal computer

PROCEDURE:

Error messages encountered during boot before Windows loads

Ensure that your computer BIOS settings are correctly configured to

the hardware that is installed in your computer

Error messages while windows loading

1. If you have recently installed or changed something that could have caused

normal windows to stop loading, try loading the last known good configuration

2. If you are unable to get into Normal windows and believe that removing or
uninstalling a program or changing a setting may help enable you to get into
windows, boot the computer into windows XP safe mode

3. If your computer has worked fine in the past but recently has been
experiencing the issue you are encountering run the system restore option to

restore the computer to an earlier date

Other error messages that occur while windows is loading or after windows
is loaded

1. If error occurs but windows still loads, verify no issues or conflict exits in
device manager
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2. Ensure that if programs are loading automatically that these errors are

not associated with these programs

3. Make sure Windows XP is up to date by checking Microsoft windows

update page

4. 1f your computer has virus protection installed make sure that it is up to

date and that no virus are being detected

5. If your computer has worked fine in the past but recently has been
experiencing the issue you are encountering run the system restore option to
restore the computer to an earlier date

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment
RESULT: Malfunctioning CPU due to system software is done

Viva questions and Answers:

1. Define a software trouble shooting?

2. What is the system restore?

3. How much the free hard disk drive space?

4. What to Do With the Issues That May Pop Up At the Time of USB Device
Installation?

5. How do you remove a virus from a computer?

6. What is BIOS and how does it affect a computer device?

7. Inyour opinion, what situations typically require a simple replacement of a power
cable?

8. Can you tell me about a time when you couldn't troubleshoot a problem? What did you
do?

9. Do you have experience troubleshooting printer problems? If so, what examples can
you provide?

10. My computer has no sound. What do you do to determine the cause and correct the
issue?

11.1 can't see the display on my computer. What's wrong and how can | solve it?

12.1 can't turn my computer on, no matter how many times I try. What's happening?

13. My keyboard won't let me type. How would you troubleshoot this situation and
determine a solution?

14.How do you test memory on a computer?

15. How would you clean a computer fan? And when would you do so?
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TASK 5:

Orientation & Connectivity Boot Camp: Students should get connected to
their Local Area Network and access the Internet. In the process they
configure the TCP/IP setting. Finally students should demonstrate how to
access the websites and email.

AIM: To learn Local Area Network and access the Internet. In the process they
configure the TCP/IP setting. Finally students should demonstrate, to the
instructor, how to access the websites and email

Software Requirement: Local Area Network to access the

Internet Hardware Requirement: Personal computer THEORY':

The internet is a worldwide, publicly network of interconnected computer
networks

LOCAL AREA NETWORK:

LANSs are privately owned networks within a single building or campus of up to
few kilometers in size.

WIDE AREA NETWORK:

A WAN is a network that connects computers across a large geographic area
such as a city or country

TCP/IP (Transmission Control Protocol/Internet Protocol):

Collection of methods used to connect servers on the internet and to exchange
data.

HTML (Hyper Text Markup Language):

The coding used to control the look of documents on the web
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HTTP (Hyper Text Transfer Protocol):

Part of a url that identifies the location as one that uses HTML

IP (Internet Protocol):

A format for contents and addresses of packets of information sent over

the internet

IP ADDRESS:

An identifier for a computer or device on a TCP/IP network

SEARCH ENGINE:

A program that searches documents located on the Internet for keywords or

phrases entered by a person browsing the net.
Internet Connection requirements:

| TCP/IP protocol

| Client Software

| ISP Account
Means of communication to the net:

telephone Modem

Ethernet

ISDN(Integrated Services Digital Network)
DSL(Digital Subscriber Line)

Satellite.

- - - L L

PROCEDURE:
Go to start>control Panel

open Network Connections

Click create a new connection and then click next

A\ =

The new connection wizard window opens , click next
to continue
5. Choose one of the options in the next dialog box

IT Workshop Lab Manual Page 39



6. Choose one of the three options in the next dialog box
| 1f you do not have an internet account click choose from a list of I1SPs and

then click next

o If you have an account click Set up my connection manually
o If you have a CD from the ISP click use the CD I got from an ISP and then
click next

7. Follow the next steps as per the option you selected.
TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment

RESULT: In this way we can learn surfing the web

1. Define internet

2. What is the Intranet?

3. What is a sneaker net?

4. What is the full form of LAN?

5. What is the full form of WAN?

6. What are different types of LAN topologies?
7. What is TCP/IP?

8. What is MAC address?

9. What are different types of LAN devices?
10. What is difference between LAN and Private VLAN?
11. What is a node?

12. What is difference between Hub and Switch?
13. What is the full form of HTTP?

14. What is the full form of TCP/IP?

15. What is the full form of ISDN/DSL?
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TASK 6:

Web Browsers, Surfing the Web: Students customize their web browsers
with the LAN proxy settings, bookmarks, search toolbars and pop up
blockers. Also, plug-ins like Macromedia Flash and JRE for applets should

be configured

AIM: To learn to surf the web
Software Requirement: Local Area Network to access the Internet
Hardware Requirement: Personal computer
THEORY:
1 Web browser provides the means to the searching and also helps b
Download the web content.

| Web browsers support most of the famous Internet Protocols like HTTP,
FTP.

| Common file formats a browser accepts are HTML
| Well known browsers natively support a variety of other formats n

addition to HTML such as JPEG,PNG,GIF image formats

| Different web browsers available in the market are:
rsmith

Mosaic

Netscape

Mozilla

Opera

Lynx

MMM

Safarl
Bookmark:

Each web browser is built-in with the support of Internet Bookmarks which serve as

a named anchor — primarily to URLs. The primary purpose of this book mark is to
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easily catalog and access web pages that the web browser user has visited or

plans to visit, without having to navigate the web to get there.

Pop-up Blockers:
Pop-ups are a form of online advertising on the WWW intended to attract the
attention of the users. These pop ups are hosted on the web sites which are
frequently visited by the netizens. These pop ups are activated when these web
sites open a new web browser window and there by displaying the
advertisements.
Plug-ins:
A plug-in is a software component program that interacts with a main application
to provide a better integration of the media. The basic difference between
application programs and plug-ins is that multimedia files are launched in a
separate window where as in plug-ins multimedia play in the browser window.
Few famous plug -ins are:

| Apple Quick Time

| Macromedia flash

| Microsoft Media Player

| Adobe Shockwave

| Sun Microsystems Java Applet

PROCEDURE: LAN

Proxy Settings:
| select tools menu in Internet Explorer
| Select Internet Options
J Select Connections

] 'You end up in two options
Y
Dial-up and virtual network settings

IT Workshop Lab Manual Page 42



Y
LAN setting

J The selection at this step is dependent on the kind of connection you are trying to
oconfigure. They are:

Dial-up modem connection

;

LAN connection

=Y
DSL or Cable modem

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment

RESULT: In this way we can learn surfing the web

VivaQ & A:

1) What is the tool needed to surf the internet?

2) What is the first commercial browser?

3) What are the popular web browsers?

4) What Is The Purpose Of Web Browser?

5) What Is A Web Browser?

6) What Is Plug-in?

7) What Is A Safer Web Browser?

8) What Are Http And Https?

9) Which Is The Fastest Web Browser?

10) What Is The Support Being Provided To Web Browser?
11) What Are The Privacy And Security Features Being Provided By Web Browsers?
12) What Is Hyperlink?
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TASK 7:

Search Engines & Netiquette: Students should know what search engines are
and how to use the search engines. Usage of search engines like Google,
Yahoo, ask.com and others should be demonstrated by student.

AlM: To know what search engines are and how to use the search engines.

Software Requirement: Local Area Network to access the Internet

Hardware Requirement: Personal computer

THEORY:

Search engine:

A search engine can be defined as a web site with tools which help you to

find information on the internet

Function of a search engine:

You can find anything from a schedule of White house tours to instructions

for removing stains from clothes.

Limitations:

Search engines visit web sites only several weeks. Search engines cannot

see information in other data bases later on.

On the internet a search engine is a coordinated set of programs that includes: A
spider (crawler or bot) that goes to every page or representative pages on every
web site that wants to be searchable and reads it , using hypertext links on each
page to discover and read site‘s other pages.

Pros:

You can select the search terms

You can use the same search terms with multiple search engines

You can change search terms as much as you wish

 — — L

You will normally receive numerous links
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| Its fast

Cons:
| There are so many different search engines it may be difficult to
choose
1 You will normally receive too many links often making it difficult b
identify the most relevant sites.
] The vast majority of links may be only marginally relevant @
altogether irrelevant
EX:
] Alta Vista
1 Ask Jeeves
] Google
] Lyoos
Etc...

Meta Search Engines:

Meta search engines or —metacrawlersl don‘t crawl the web themselves. Instead
they search the resources of multiple search engines by sending a search to
several search engines at once aggregating the result.

Pros:

1 You only need to use one search tool which is time- efficient

1 You only need to learn how to use one search engine reducing
learning curve

1 You benefit from the difference among several search tools at once
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Cons:
o Meta search services may not be able to leverage each individual search
engines full range of query tools resulting in less refined searches

o You can not personally select the search engines queried by Meta search

Services.

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment
RESULT: In this way we can know what search engines are and how to use

the search engines

VivaQ & A:

1) Define search engine

2) What is a spider?

3) Give the main purpose of WWW

4) What is SEO? What are the important types of SEO methods?
5) What are the SEO tools do you use?

6) What do you mean by Back link?

7) What are outbound Links?

8) What are outbound Links?

9) Name some SEO blogs that help you to enhance your content marketing strategies
10)Why is Title Tag on Website valuable?

11)How do backlink tools work?
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TASK 8:

Cyber Hygiene: Students should learn about viruses on the internet and
install antivirus software. Student should learn to customize the browsers to
block pop ups, block active x downloads to avoid viruses and/or worms.
AIM: To learn various threats on the internet and configure the computer to

be safe on the internet.

Software Requirement: Antivirus Software

Hardware Requirement: Personal computer

THEORY:

Antivirus:

Antivirus software is a program that either comes installed on your computer or
that you purchase and install yourself. It protects your computer against most
viruses, worms, Trojan horses and other unwanted invaders that can make your
computer sick.

Firewall:

A firewall is a special software or hardware designed to protect a private
computer network from unauthorized access. A firewall is a set of related
programs located at a network gateway server which protects the resources of the
private network from users from other networks.

PROCEDURE:

Installing Symantec antivirus for Windows:

| Insert Symantec antivirus CD into your CD drive
| Double click on the Symantec-setup.exe

| The installer will open
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| Click next to proceed

 License agreement will open. Click | accept the terms of the
license agreement and then click next.

| Follow the instruction on the screen to complete the installation.

Get Computer Updates:

] Click start> settings>control panel

| Click Automatic Updates icon to open Automatic Updates dialog
box

| Check the box Keep my computer up to date
] Choose a setting
| Click OK
Block Pop ups:
1 In the IE open tools>pop-up blocker
| Click on Turn on Pop- up blocker

Windows Firewall:

] Go to Start>control panel>Network and Internet Connections >windows
firewall

] In the general tab check the On(recommended) box

1 If you don‘t want any exceptions check on Don’t allow exceptions
box
TEST DATA: No Test data for this Experiment

ERROR: No Errors for this Experiment
RESULT: Antivirus is installed in the system
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VivaQ & A:

What is antivirus software?

What is a firewall?

What are the three basic types of Firewall?

What are the advantages of cyber security?

What is cyber security?

What is port scanning?

How to prevent CSRF attacks?

List the common types of cyber security attacks.

. What is the use of a firewall and how it can be implemented?

0 What are the techniques used in preventing a Brute Force Attack?

Ho@N@WPW!\’P
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TASK 9:

Develop home page: Student should learn to develop his/her home page using
HTML consisting of his/her photo, name, address and education details as a
table and his/her skill set as a list.

AlM:
To create a your web page using HTML

Software Requirement: Notepad, Any web browser

Hardware Requirement: Personal computer
CODE:

<html|>
<head>
<title> details</title>
</head>
<body>

<img src="photo.jpg" height=100 width=100>
<h1> NAME : Radha</h1>
<hl><pre>
Address:
H.NO.1-241/29,
Kukatpally,
Hyderabad-500062
</pre></h1>
<h1> Educational Details</h1>

<table border=1>

<tr>
<th>Course </th>
<th>Name of the Institutation</th>
<th>Year of Pass</th>
<th>Percentage</th>

</tr>

<tr>

<td>M.Tech(CSE)</td>

<td>Vasavi College of Engineering</td>
<td>2011</td>

<td>81%</td>
</tr>
<tr>
<td>B.TEch(CSE) </td>
<td>CVR Engineering College</td>
<td>2009</td>
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<td>75%</td>
</tr>
<<tr>
<<td>Intermediate </td>
<td>Sri Chaitanya</td>
<td>2005</td>
<td>89%</td>
</tr>
<td>SSC</td>
<td>Little Buds High School</td>
<td>2003</td>
<td>85%</td>
</tr>
</table>
<h1>Technical Skills:</h1>
<ultype=disc>
<li>Programming Languages : C, JAVA</li>
<li>Operating Systems  : Windows </li>
<li>Database Systems  : Oracle</li>
<li>Web Technologies  : HTML</li>
</ul>
</body>
</htm|>

TEST DATA: Execute the code with any browser
ERROR: No Errors for this Experiment

RESULT: web is developed which consisting of photo, name,  address and
education details and skill

e B sew Moy Sedanaks Bl tRiR
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Viva Questions and Answers:

1) What is HTML?

2) What are the different tags available?

3) What is web page?

4) What web developer should know?

5) List out the advantage of HTTP/2 as compared with HTTP 1.1?

6) Explain what is an ETag and how does it work?

7) Explain what is DTD (Document Type Declaration)? Mention what is the difference
between CDATA and PCDATA in DTD?

8) In HTML what tag can be used for a multi-line text input control?

9) List out few ways you can reduce page load time?

10) How XHTML is different from HTML?

11) List out the new APIs provided by HTML 5 standard?

12) Mention what is the correct way to include JavaScript into your HTML?
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TASK 10:

To create project certificate, Features to be covered:-Formatting Fonts in
word, Drop Cap in word, Applying Text effects, Using Character Spacing,
Borders and Colors, Inserting Header and Footer, Using Date and Time
option in both LaTeX and Word.

AlM:

To create a document applying the above mentioned techniques.

Software Requirement: MS-WORD

Hardware Requirement: Personal computer

THEORY:
Header and Footer:
1. To create a header, enter text or graphics in the header area
or click button on the header and footer tool bar.
2. To create footer, click switch between header and footer.
3. Then click exit.

Date and Time:

Insert a date field that automatically updates so that the current date is
displayed when you open or print the file.
Insert a time field that automatically updates so that the current time
is displayed when you open or print the file.
Border:
e On the format menu, click borders and shadings.

e To specify that the border appears on a particular side of a page, such as only
at the top, click custom under setting.
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e To specify a particular page or section for the borders to appear, click the
option you want to apply.

e To specify the exact position of the border on the page. Finally, click OK.
Color:

e Select the text you want to make a different color.
e To apply the color most recently applied to text, click font color.

e To apply different colors, click the arrow on the right of the font color button,
select the color you want and then click the button.

PROCEDURE:

First click start button on the status bar. Then select program and again
select Microsoft word. On the menu bar click the file option. Then again click
new. Then enter the text not less than 100 words. A header appears at the top and
the footer appears at the bottom of each page. On the view menu, click header
and footer option. From dialogue box, make the required changes and then click
OK. On the format menu, click borders and shading s make required changes and
the click OK. Select the text you want and make the different color. Click on
right of the font color button, and then select the color you want and then click on
the button.

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment
RESULT: A document is created by applying the above mentioned techniques

Viva Questions and Answers:

1) What is MS word?

2) What is a title bar?

3) What is menu bar?

4) What is a tool bar?

5) How you can create a custom watermark?

6) How can a break be deleted in the column?

7) How is editing restricted in MS Word?

8) How is cross-referencing created in MS Word?

9) What are the steps to create a macro in MS Word?
10) How is watermark created in MS word?
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TASK 11:
Creating project abstract Features to be covered:-Formatting Styles,
Inserting table, Bullets and Numbering, Changing Text Direction, Cell

alignment, Footnote, Hyperlink, Symbols, Spell Check, Track Changes.

AlM:
To create a document applying the above mentioned techniques.
Software Requirement: MS-WORD

Hardware Requirement: Personal computer

THEORY:
Table:

A table consists of rows and columns.
Cell Alignment:

Aligns contents written in a table in the top left corner or top right

corner or in the center etc...
Foot Note:

Foot notes are used to comments on, or provide references for text in a
document.

Hyperlink:

It is a colored and underlined text or a graphic that you click to go to a file, a
location in a file, an HTML page on the World Wide Web, or an HTML page in an
intranet.

Symbols:

You may not be able to enter certain symbols into your word document, as there
is a limitation on the keys on the key board. Creating these new symbols especially
when working with mathematical terms it becomes very difficult .For example we

can insert symbols such as=,=, ,..
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Spell check:
It automatically checks for spelling and grammatical errors

Bullets and Numbering:
In Microsoft word we can easily create bulleted or numbered list of

items.
Formatting Styles:

o Astyle is aset of rules to be followed for the effective document.

o Style can be applied to text, paragraph, table or a list.

Changing text direction:

You can change the text orientation in drawing objects, such as text boxes,
shapes, and callouts, or in table cells so that the text is displayed vertically or
horizontally.

Track changes:

A track change is an excellent feature of Microsoft word as it enables a
user or reviewer to keep track of the changes that have taken a period. Changes like
insertion, deletion or formatting changes can be kept track of.

Procedure:

Changing Text direction:

1. Click the drawing object or table cell that contains the text you want to
change.

2. On the Format menu, click Text Direction.

3. Click the orientation you want.

Table:

Click where you want to create a table.

On the Table menu, point to Insert, and then click Table.
Under Table size, select the number of columns and rows.
Under AutoFit behavior, choose options to adjust table size.
To use a built-in table format, click AutoFormat.

NARER A
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Select the options you want

Cell Alignment:

1.
2.

Click the cell that contains text you want to align.

On the Tables and Borders toolbar, select the option for the horizontal and
vertical alignment you want— for example, Align Bottom Center or Align
Top Right.

Foot Note:

1.

2.
3.

In print layout view, click where you want to insert the note reference
mark.

On the Insert menu, point to Reference, and then click Footnote.
Click Footnotes or Endnotes.

By default, Word places footnotes at the end of each page and endnotes at
the end of the document. You can change the placement of footnotes and
endnotes by making a selection in the Footnotes or Endnotes box.

In the Number format box, click the format you want.
Click Insert.

Word inserts the note number and places the insertion point next to the
note number.

Type the note text.
Scroll to your place in the document and continue typing.

As you insert additional footnotes or endnotes in the document, Word
automatically applies the correct number format.

Hyper link:

Select the text or picture you want to display as the hyperlink, and then click
Insert Hyperlink on the Standard toolbar

Do one of the following:
1. Link to an existing file or web page:

1. Under Link to, click Existing File or Web Page.
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2. In the Address box, type the address you want to link to or, in the
Look in box, click the down arrow, and navigate to and select the
file

2. Link to a file you haven‘t created yet

Under Link to, click Create New Document.

3. In the Name of new document box, type the name of the new file.
4. Under When to edit, click either Edit the new document later or Edit
the new document now

An e-mail address:

1. Select the text or picture you want to display as the hyperlink, and then
click Insert Hyperlink on the Standard toolbar

2. Under Link to, click E-mail Address.

3. Either type the e-mail address you want in the E-mail address box, or select
an e-mail address in the recently used e-mail addresses box.

4. In the Subject box, type the subject of the e-mail message

A specific location in another document

1. Insert a bookmark in the destination file or Web page.
2. Open the file that you want to link from, and select the text or object you
want to display as the hyperlink.

3. On the Standard toolbar, click Insert Hyperlink

4. Under Link to, click Existing File or Web Page.

5. Inthe Look in box, click the down arrow, and navigate to and select the
file that you want to link to.

6. Click Bookmark, select the bookmark you want, and then click OK.

Symbol:

Click where you want to insert the symbol.

On the Insert menu, click Symbol, and then click the Symbols tab.
In the Font box, click the font that you want.

Double-click the symbol that you want to insert.

Click Close

abkhown e
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Spell check:

1. On the Standard toolbar, click Spelling and Grammar
2. When Word finds a possible spelling or grammatical problem, make your
changes in the Spelling and Grammar dialog box.

Bullets and Numbering:

1. Type 1. to start a numbered list or * (asterisk) to start a bulleted list, and
then press SPACEBAR or TAB.

2. Type any text you want.

3. Press ENTER to add the next list item.

Word automatically inserts the next number or bullet.

4. To finish the list, press ENTER twice, or press BACKSPACE to delete the
last bullet or number in the list

Formatting Styles:

1. Select the words, paragraph, list, or table you want to change.

2. If the Styles and Formatting task pane is not open, click Styles and
Formatting on the Formatting toolbar
3. Click the style you want in the Styles and Formatting task pane. If

the style you want is not listed, click All Styles in the Show box
Track Changes:

1. Open the document you want to revise.
2. On the Tools menu, click Track Changes

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment
RESULT: A document is created by applying the above mentioned techniques

Vivaqg & A:

1) What is the feature of micro soft word?

2) What is the undo and redo commands?

3) What are the various cell alignments?

4) A Word 97-2003 document will be save in which extension?

5) Maximum number of text column supported by a word document is?
6) Which command will execute a new Word file in a windows machine?
7) A Word 97-2003 document will be save in which extension?
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TASK 12:

Creating a Newsletter: Features to be covered:- Table of Content, Newspaper
columns, Images from files and clipart, Drawing toolbar and Word Art,
Formatting Images, Textboxes, Paragraphs in word.

AlIM : Create a news Letter
Software Requirement: MS-WORD

Hardware Requirement: Personal computer

THEORY:
Table of contents:

Table of contents displays a list of headings in a created
document. It basically provides an outline of the entire document created

Newspaper columns:

One can create a newspaper columns document by specifying the
number of new letter-style column required and then adjust their width , and add
vertical lines between columns.

Images from files and clipart:

Inserting a picture (graphic) from a file and clipart may be required
for a document. This picture could be a scanned photograph or any other digitally
produced one. This pictures can be modified , resized, cropped and enhanced.
Drawing toolbar and Word Art:

One can create his/her own drawings in Microsoft word. Ms word provides

a full fledged drawing tool bar.

Word Art in Microsoft word enables you to create special and decorative text.

Formatting Images, Textboxes and Paragraphs:

Formatting an image includes selecting appropriate color, size, layout
and cropping.

Generally the text in a document follows a standard orientation (line after
line). A text box provides a different orientation to the text with in a document. It
can arrange the text in anywhere and can be resized and moreover moved to any
section of the document or even outside.
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When you are formatting a paragraph, you do not need to highlight the entire
paragraph. Placing the cursor anywhere in the paragraph enables you to format it.
After you set a paragraph format, subsequent paragraphs will have the same
format unless you change the format

PROCEDURE:

Table of contents:

Click where you want to insert the table of contents.

On the Insert menu, point to Reference, and click Index and Tables.
Click the Table of Contents tab.

To use one of the available designs, click a design in the Formats box.
Select any other table of contents options you want.

howp =

Newspaper columns:

1. Select the entire or part of document to be converted into a newsletter-style

2. Click on format menu , select columns

3. Any desired number of columns are presets-one or two or three or left or right
b\can be selected.

4. Width and spacing can be fixed and equal columns width can be checked for
uniformity

5. If newspaper columns are to be separated by a line, then check line between

6. Under apply to will be whole document if entire document is selected else we
have to select a selected text.
7. Click ok

Inserting images from files and clip art:

1. Click where you want to insert the picture.

2. On the Insert menu, point to Picture, and then click From File.
3. Locate the picture you want to insert.

4. Double-click the picture you want to insert.

CLIP ART:

1. On the Insert menu, point to Picture, and then click Clip Art.
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2. In the Clip Art task pane, in the Search for box, type a word or
phrase that describes the clip you want or type in all or some of the
file name of the clip.

3. To narrow your search, do one or both of the following:

To limit search results to a specific collection of clips, in the
Search in box, click the arrow and select the collections you
want to search.

To limit search results to a specific type of media file, in the
Results should be box, click the arrow and select the check
box next to the types of clips you want to find.

4. Click Go.

5. If you don't know the exact file name, you can substitute wildcard
characters for one or more real characters. Use the asterisk (*) as a
substitute for zero or more characters in a file name. Use the question mark
(?) as a substitute for a single character in a file name.

6. In the Results box, click the clip to insert it.
Drawing Toolbar and Word Art:

1. Click in your document where you want to create the drawing.
2. On the Insert menu, point to Picture, and then click New

Drawing. A drawing canvas is inserted into your document.
3. Use the Drawing toolbar to add any shapes or pictures that you

want

WORD ART:

1. On the Drawing toolbar, click Insert WordArt 2.
Click the WordAurt effect you want, and then click OK.

3.In the Edit WordArt Text dialog box, type the text you want.
4.Do any of the following:

] To change the font type, in the Font list, select a font.
| To change the font size, in the Size list, select a size.
| To make text bold, click the Bold button.
| To make text italic, click the Italic button.
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Formatting Images:

1. Formatting of the images can be achieved by selecting the image and
double click on the picture, format picture dialog box appears.

2. The same can be achieved by selecting the tools menu > customize>tool
bars tab>picture and click close.

Basic formatting features of an image

Resize a drawing

1. Select the drawing canvas
2. On the Drawing Canvas toolbar, do one of the following:

o To make the drawing canvas boundary larger without changing the
size of the objects on the canvas, click Expand
o To make the drawing canvas boundary fit tightly around the drawing

objects or pictures, click Fit

o To scale the drawing and make the objects and canvas proportionately
smaller or larger, click Scale Drawing, and then drag the edges of the
canvas.

Resize a picture or shape

1. Position the mouse pointer over one of the sizing handles
2. Drag the sizing handle until the object is the shape and size you want.

To increase or decrease the size in one or more directions, drag the mouse
away from or toward the center, while doing one of the following:

o To keep the center of an object in the same place, hold down CTRL
while dragging the mouse.

o To maintain the object's proportions, drag one of the corner sizing
handles.

o To maintain the proportions while keeping the center in the same place,
hold down CTRL while dragging one of the corner sizing handles.
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Crop a picture
1. Select the picture you want to crop.

2. On the Picture toolbar, click Crop
3. Position the cropping tool over a cropping handle and then do one of the
following:
o To crop one side, drag the center handle on that side inward.
o To crop equally on two sides at once, hold down CTRL as you drag
the center handle on either side inward.
o To crop equally on all four sides at once, hold down CTRL as you
drag a corner handle inward.

4. On the Picture toolbar, click Crop to turn off the Crop command.

Text Box:

1. On the Drawing toolbar, click Text Box

2. Click or drag in your document where you want to insert the text box

3. You can use the options on the Drawing toolbar to enhance a text box—
for example, to change the fill color— just as you can with any other
drawing object

Paragraphs: Change line spacing
Select the text you want to change.

1. On the Formatting toolbar, point to Line Spacing, and then do one of
the following:
o To apply a new setting, click the arrow, and then select the number that
you want.
oTo apply the most recently used setting, click the button.
o To set more precise measurements, click the arrow, click More,
and then select the options you want under Line Spacing.

Change spacing before or after paragraphs

1. Select the paragraphs in which you want to change spacing.

2. On the Format menu, click Paragraph, and then click the Indents and
Spacing tab.

3. Under Spacing, enter the spacing you want in the Before or After box.

Change paragraph direction

1. Place the insertion point in the paragraph that you want to change, or select
several paragraphs.
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2. Do one of the following:
o To have text begin from the left, click Left-to-Right on the Formatting
toolbar.

o To have text begin from the right, click Right-to-Left on the Formatting
toolbar.

When you change the paragraph direction, Microsoft Word leaves justified and
centered text as it is. In the case of left-aligned or right -aligned text, Word flips
the alignment to its opposite. For example, if you have a left-to-right paragraph
that is right aligned, such as the date at the top of a letter, clicking Right-to-Left
results in a right-to-left paragraph that is left aligned.

Forms:

Using Microsoft word one can create an organized and structured document with
a provision to enter the required information into it. A document of such nature is
called a form.

Mail Merge:

It helps us to produce from letters mailing labels envelopes catalogs and
others types of merged document. It is so found in the tools option on the menu
bar. In tools we have letters and mailing. In letters and mailing we have mail
merge mail merge tool box envelopes tables and letters wizard. In mail merge
select the required document you are working on. A window for customizing the
data base structure appears. This file contains the names, address details with
contact numbers etc of people you wish to send the letters.

Inserting objects:

Insert an object such as drawing word art text effects or an equation at
the inserting point.
Fields:

It inserts a field at the inserting font fields are used to insert a variety of
information automatically. Select table in table select insert. In that select insert
table a box containing number of rows and columns will appear. Select six colors

and four rows and click o.k. Given the first row as date, problem repeated
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student‘s signature action recommended problem status and councilors sign.

Insert the objects in the feedback form and apply the text fields in the form.

PROCEDURE:
Mail Merge:

1.

»

Open a document and type the complete body of the letter and format it
as required.

Create a data source and choose mail merge from tool bar a window is
displayed.

Click on create button and choose from letter options. Then a window is
displayed.

Click active window choose currently active document. Click on data

and create data source option.

. A window for customizing the data base structure appears and this file

contains the names address details with contact number etc. we can add

or remove fields from this file.

. Once the list of fields is finalized a window of same is displayed and

types the required file names and click on save button.

. A window is displayed. Type the details of 10 candidates. After typing

details of one person, click on add menu.

Click on the o.k. to finish entering the records mail merge tool bar is
displayed.

Place the curser at the place where you wish to insert names and click
on insert mail merge button. A drop list is displayed all fields created

would be shown.

10.By highlighting to desired file and click on it we can insert the field into

the main document and go to begin the mail merge click on mail merge.
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11.A window is displayed click once on the merge button to generate
letters for all records in your data source file.

Forms:

1. Design the form by sketching a layout first, or use an existing form
template as a guide. Tables, text boxes, borders, and shading are all design
elements that can help you create a well-designed form that's easy to use.

2. On the Standard toolbar, click New Blank Document .

3. Add the text or graphics you want. For example, enter the questions you
want answered, and list the available choices.

4. To insert a text box where users can enter their responses, click the
document, and then click Text Form Field on the Forms toolbar. If you
need more space, you can insert multiple text boxes side by side. To insert
check boxes that list choices, such as Yes and No, click the document, and
then click Check Box Form Field on the Forms toolbar.

5. Save the form.

Insert line numbers:

1. On the File menu, click Page Setup, and then click the Layout tab.

2. Inthe Apply to box, click Whole document.

3. Click Line Numbers.

4. Select the Add line numbering check box, and then select the options you
want.

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment
RESULT: A document is created by applying the above mentioned techniques

Vivagq & A:

1) What is a table of content?

2) What is word art?

3) What is the function of a text box?

4) What is a Form?

5) What is the purpose of checkbox?

6) What is the mail merge?

7) How do | create a Table of Contents in MS Word?

8) What are the shortcut keys for creating hyperlink?

9) When should Heading Styles be applied in the TOC process?
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TASK 13:
Spreadsheet Orientation: Accessing, overview of toolbars, saving

spreadsheet files, Using help and resources. Creating a Scheduler:-

Gridlines, Format Cells, Summation, auto fill, Formatting Text.

AlIM: To maintain a shift schedule with specifications
Software Requirement: MS-EXCEL

Hardware Requirement: Personal computer

THEORY:

Grid lines:

1.

. On the file menu, click page setup and the click the sheet tab.

Click the worksheet.

2
3. Click gridlines.
4,
5
6
7

Select the sheets on which you want to change the gridlines color.

. On the Tools menu click options click the color you want in the color box.
. To use the default gridlines color click automatic.

. Lines you can add to a chart that make it easier to view and evaluate data.

Gridlines extend from the tick marks on an axis across a plot area.

Format Cell:

1
2

Change the font and font size.

Change the text color.

3. Make selected text or numbers bold, italic or underlined.
4. Create a new style.
Auto fit:
1. Combine cells horizontally or vertically to make one large cell.

2.
3.

4.
S.
6.

Add borders to cells.

Shade cells with colors.

Change the column width and row height
Change the font, font size or colors of text.

Align text vertically at the top, center and bottom of cell.
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Formatting the text:

1.

Select the text you want to format.

2. On the format menu click cells and then click number tab.
3. In the catalog box click text.

4,
5
6

Enter the numbers in the formatted cells.

. Click ok.

. Then press enter and reenter the data.

PROCEDURE:

First click start button of the screen on status bar. Click on programs and

then Microsoft excel. To get a new blank work sheet go to programs and then

click on excel sheet. On the file menu click page setup and then click sheet tab

click gridlines. In this way do the required changes using format cell, make the

required changes using formatting text also make the required changes. Enter the

data in the data in the worksheet consisting of week name person name and

timings 7 a.m. to 3 p.m. Make all the above changes to the text.

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment

RESULT: A Excel Sheet is created by applying the above mentioned techniques
VivaQ & A:

1) What do you mean by a spread sheet?
2) What is the Auto Fill?

3) What is a grid line?

4) Explain MS Excel in brief?

5) What do you mean by cells in an Excel sheet?
6) Explain what is a spreadsheet?

7) What do you mean by cell address?

8) Can you add cells?

9) Can you protect workbooks in Excel?

10) Can you protect workbooks in Excel?
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TASK 14:
Calculating GPA - .Features to be covered:- Cell Referencing, Formulae in
spreadsheet — average, std. deviation, Charts, Renaming and Inserting
worksheets, Hyper linking, Count function, Sorting, Conditional formatting.
AIM:
To maintain a control chart for printing books with given data.
Software Requirement: MS-EXCEL
Hardware Requirement: Personal computer
THEORY:
1. On the chart menu click chart type
2. Text direction.
Click the arrow down next to the text direction button. For right to left click
right to left. For left to right reading order, click left to right.
For reading order that is consistent with the language of the first entered
character, click context. For reading order that is inconsistent with the
language of the first entered character, click control.
3. In the tools menu click options and then click chart tab.
4. To show all worksheet data in the chart even if some rows and columns are
hidden, clear the plot visible cells by check box.
5. To prevent hidden rows and columns from displaying in the chart, select the
plot cells only check box.
Hyper Linking:
1. Create a worksheet: On the file menu, click new, and then click
blank workbook taskpane.
2. Insert a worksheet: C lick worksheet on the insert menu. Right click
on sheet tab and then click insert double click the template for the

type of sheet you want.
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3. Hyperlink: Using hyperlink we can insert one more sheet in the present

sheet

4, Count function: Create a blank worksheet press control +c. In the
worksheet select cell A and press control +c. On the tools menu point to
formula auditing and then click formula auditing menu.
Worksheet:
1. In the file menu go to menu then a new worksheet is created.
2 To add a single worksheet, click worksheet on the Insert menu. To add
multiple worksheets hold down shift and then click the number of
worksheet tasks to add in an open workbook
Sort:
1. Click a cell in the list you want to sort.
2. On the Data menu click sort.
3. Under first key sort click the custom sort order you want and then click ok.
4. Click any other sorting option you want.
PROCEDURE:

Formulae in Excel:

First click on start button at the bottom of the screen on status bar. Click on
programs and then on Microsoft excel. Then open a new document. Give the
main heading and subheading by changing the size so that they look in block
letters. Enter the data. To calculate go to Insert menu in the menu bar and then
click on function and then ok. Then select the data to which you want to calculate
mean. Then you get the required answer. In same way, sample means standard
deviation lower count limit and upper count limit. Go to insert menu and click on
function and select the required operation to be done and select the data and

calculate. Formulas for all the above are given below.

Mean = (s1 + s2 + s3 + s4 + s5)/5;
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Sample mean = avg (mean)

Standard deviation = (mean, sample, mean)

Sample standard deviation= avg (Standard deviation)

Lower count limit = sample mean — sample standard deviation.
Upper count limit = Sample mean + Sample Standard deviation

Hyper linking:

First click on start button of the screen on status bar. Click on
programs and then Ms-excel. To get a new blank worksheet go to programs and
then click on excel sheet. Rename the first sheet as student by right clicking on
sheet 1 and renaming. Insert hyperlink insert and click on hyperlink. Then go to
sheet 2 and rename as CSE type in particulars of ECE right click on sheet 3. Then

go to sheet -4 rename as IT. In this type all the four sheets are created.

WORKSHEET
First click on start button at the bottom of the screen on status bar.
Click on programs and then Ms-excel. Then enter the data as given. Enter the
student‘s names, Subjective wise marks, total and avg. Then calculate the total
and avg by using formula. Then go to Data menu and click sort. Under first key
sort, click custom sort order needed i.e. ascending order or alphabetical order and

then click o.k. Then the required worksheet is prepared.

Count Function
Some of the content in this topic may not be applicable to some languages.
1. To count words in selected text only, select the text you want.

If you don't select any text, Microsoft Word counts the words in the whole
document.
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2. On the Tools menu, click Word Count.
Word displays counts for words, paragraphs, lines, and characters.

3. To add or remove footnotes and endnotes from the count, select or
clear they Include footnotes and endnotes check box.

VLOOKUP and HLOOKUP Functions

This document explains the functions of VLOOKUP and HLOOKUP and how
to use them in a spreadsheet. It can be used in all versions of Microsoft Excel.

VLOOKUP and HLOOKUP are functions in Excel that allow you to search a
table of data and based on what the user has supplied and give appropriate
information from that table.

If you have a table of Student ID numbers, Student Names and Grades, you
can set up Excel so that if a Student ID number is supplied by the user, it will
look through the table and output the student's name and grade.

A B C
VLOOKUP
Student ID Number 1234 <— User supplied
Student Name John Smith <4— From table
Semester Grade A/B <«—— From table

VLOOKUP allows you to search a table that is set up vertically. That is, all of
the data is set up in columns and each column is responsible for one kind of data. In
the Student Record example, there would be a separate column of data for Student
Names, one for Student ID numbers, etc.

HLOOKUP is the exact same function, but looks up data that has
been formatted by rows instead of columns.
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Student ID Number 1234 1689 2495 3697 9228
Student Name John Smith Jane Jones Michelle Schreiner | Jack Lepak Rod Arneson
Semester Grade AB BIC B A B

The format of the VLOOKUP function is:
VLOOKUP (lookup _value, table _array, col _index num, range _lookup)

The lookup _value is the user input. This is the value that the function uses
to search on. If you are searching a table by the Student ID number, then
the lookup _value is the cell that contains the inputted Student ID number
being looked up.

The table _array is the area of cells in which the table is located. This
includes not only the column being searched on, but the data columns for
which you are going to get the values that you need. Back to the example, the
table_array would not only include the Student ID number column, but the
columns for the Student Names and Grades as well.

The col _index num is the column of data that contains the answer that you
want. If your table is set up as: column 1 - Student ID Number, column 2 -
Student Names, column 3 - Grades and you inputted a Student ID Number and
you want to retrieve the grade that was received for that person, the col _index
_num would be 3. 3 is the column number of the data column for the ANSWER
that you are trying to look up.

Range _lookup is a TRUE or FALSE value. When set to TRUE, the
lookup function gives the closest match to the lookup _value without going
over the lookup _value. When set to FALSE, an exact match must be found
to the lookup _value or the function will return #N/A. Note, this requires
that the column containing the lookup value be formatted in ascending
order.

To use the Function Wizard to insert a VLOOKUP function:

1. Select the cell that will contain the answer to the VLOOKUP and select
Insert -> Function...

2. Under the Function Category, choose either All or Lookup & Reference.

3. Under the Function Name, select VLOOKUP, and hit OK.

| Paste Function V - ‘ » E

HLOOKLP
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4. The Function Wizard for VLOOKUP will then display. The 4 values
talked about above (lookup _value, table _array, col _index _num,
range_lookup) are required by the function. Each line for  each value
required. If you put the cursor into the first line for lookup _value,
down below it explains what the lookup _value is for your reference.
Similar information is displayed when the cursor is in any of the other
fields.

(T - |
I |

5. Enter in the lookup _value either by typing in the number for the cell, or,
by selecting the cell on the worksheet.

6. Enter in the table _array by typing in the numbers for the cells, or,
by selecting the group of cells on the worksheet.

7. Enter in the number for column which contains the data that you wish to
obtain in the col _index _num area.
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8. Enter into the range _lookup field the value TRUE if the function
should accept the closest value to your lookup _value without going
over or FALSE if an exact match is required.

9. Hit OK when ready.

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment

RESULT: An Excel Sheet is created by applying the above mentioned
techniques

VivaQ & A:

1) What is an average function?

2) What is the syntax of average function?
3) What is a count function?

4) Can you protect workbooks in Excel?
5) Average Formula:

6) MAX Formula:

7) VLOOKUP function

8) MIN Formula:
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TASK 15:

Creating Power Point:Student should work on basic power point utilities and tools
in Latex and Ms Office/equivalent (FOSS) which help them create basic power point
presentation. PPT Orientation, Slide Layouts, Inserting Text, Formatting Text,
Bullets and Numbering, Auto Shapes, Lines and Arrows, Hyperlinks, Inserting
Images, Tables and Charts

TITLE:

Create a power point presentation consists of slide layouts inserting text,
formatting text, bullets and numbering of five slides with following
information’s.

Slide 1 — contents
Slide 2 — Name

Slide 3 — Address
Slide 4 — Hobbies
Slide 5 — Friends

AlIM:
To maintain a PowerPoint presentation with some specifications
THEORY:

SLIDE LAYOUT:

1. On the format menu, click slide layout.

2. On the slides tab in normal view, select the slides; you want to apply a
layout too.

3. In the slide layout task pane, point to layout you and then click it.

4. A new slide can also be inserted within the task pane. Point the layout
you want the slide to have, click the arrow and then click the insert new
slide.

INSERT TEXT:
1. Text can be added to layout.

2. Align text in the top, middle or bottom of a cell.
3. Align text on the right or left, or in the center of a cell.
4. Change cell margins.
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5. Insertatab in atable.
6. To make the symbol command available, in normal view, place the
insertion point on the outbox tab or in a text place holders on the slide.
7. On the insert menu, click symbol.
8. To change fonts, click a name in the font box.
FORMATTING TEXT:
1. Select the text you want to format as superscript or subscript.
2. On the format menu, click font.
3. To show or hide text formatting, on the standard toolbar, click show
formatting.
BULLETS AND NUMBERINGS:
1. Select the lines of text that you want to add bullets or numbering to.
2. Click bullets or numbering.
AUTOSHAPES:
1. Select the auto shape that has the text you want to position.
2. Double-click the selection rectangle of the auto shape or text box and
then click the text box tab in the format dialog box.
3. In the text anchor point box, click the position you want the text to start
in.
LINES AND ARROWS:
1. In Microsoft power point, double click the chart.

2. Double click the chart item you want to change.
3. On the patterns tab, do one or both of the following.
4. To change the colors, patterns or lines, select the options you want.

5. To specify a fill effect, click fill efeect and then select the options
you want on the gradient, text patterns or picture tabs.

To return to the slide, click outside the about
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PROCEDURE:

First click on start button at the button of the screen on status bar. Click
on programs and then Microsoft PowerPoint. Go to file and new. Then you
find different pattern of slides on right side of your screen. Then select which
Is completely empty. Then enter the contents in the first slide as per given
information, name in the second slide, Address in the third slide, Hobbies in
the fourth slide and friends in the fifth slide. Except first slide, all the second,
third, fourth, fifth slides should be inserted. When you select pattern of slide
from a new slide, on slide which you selected you will find an arrow towards
its right side, click that arrow and then again click insert slide. Then save it.
Then adjust the layout. Then format the text then give bullets or numbering to
the text if required. Go to auto shapes. Select more auto shapes and insert
wherever required. Then again go to insert option and select new slides. And
select chart and a chart with datasheet appear. Give the name, roll no, marks

in three subjects and calculate the total. Then save the file.

TEST DATA: No Test data for this Experiment ERROR:
No Errors for this Experiment
RESULT: A Power point Presentation is created by applying the above

mentioned techniques

Viva Questions:

1) Explain about power point

2) What is word art?

3) Explain about slide transition

4) How can you rotate the picture in power point?
5) What is the different auto shapes available in power point?
6) What is the advantage of Microsoft PowerPoint?
7) Explain Microsoft PowerPoint

8) How can we create a video in PowerPoint?

9) What is motion path in PowerPoint?

10)What is a trigger in the context of animation?
11)What is handout master in PowerPoint?

12)
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(B) ALM:
To maintain a PowerPoint presentation using some specifications
THEORY:
HYPERLINK:
1. Select the text or object that you want to represent the hyperlink.
2. Click insert hyperlink.
3. Under link to, click place in this document.
INSERT IMAGES:
1. Click where you want to insert the picture.
2. On the drawing tool bar, click insert picture.
3. Locate the folder that contains the picture that you want to insert, and

then click the picture file.

CLIP ART:
1. On the insert menu, point to structure and then click clipart.
2. In the clipart task pane, in the search for box, type a word or phrase that
describes the clip, you want to type in all or some of the file menus of
the clip.

3. In the results box, click the clip to insert it.

AUDIO VIDEO OBJECTS:
1. On the slide show menu, click setup show. Under performance check
box. If your computer has their capability, office PowerPoint will
attempt to use it.

2. Animation performance will be much better with a video card that has
Microsoft direct 3D.

1. Click the slide where you want to place the embedded object.

2. On the insert menu, click chart.

3. Click a cell on the data sheet and then type the information you want
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To return to the slide, click outside the chart

PROCEDURE:

First click on start button at the bottom of the screen on status bar. Click on
programs and then Microsoft power point goes to file menu. Then you find
different pattern of slides on right side of your screen. Then select which is
completely empty. Then enter the name of your college in bold letters. Address
of your college in bold letters in the second slide. List of all the available
courses in the third slide, extra co-curricular activities in the fourth slide except
first slide, all the second, third, fourth slide should be inserted. When you select
pattern of slide from a new slide, on slide which you selected, you will find an
arrow towards it right side click that arrow and then again click insert slide.
Then save it the select the slide show and then select the view show option.
Then review the presentation in slide show by selecting next and after
completing the slide show then click end show. Click on start button at the
button of the screen on status bar, click on programs and then Microsoft power
point. Go to file menu. On insert menu and select table option and give no. of
rows and no. of columns and give the name, Roll no and marks in three subjects
and find the total

TEST DATA: No Test data for this Experiment
ERROR: No Errors for this Experiment
RESULT: A Power Point Presentation is created by applying the

above mentioned techniques

Viva Questions:
1. Define hyper link

2. Define slide show

3. Define slide transition

4. What is animation

5. How can you insert a table in power point?
6. What is handout master in PowerPoint?

7. What is handout master in PowerPoint?

8. What is handout master in PowerPoint?

9. What is handout master in PowerPoint?
10.What is handout master in PowerPoint?
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